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AKVIS NEON 6.1 | LEUCHTBILDER AUS FOTOS

AKVIS Neon ist eine Software zur Umwandlung von Fotos in effektvolle Neonbilder. Das Programm erstellt herausragende
visuelle Effekte und lässt Ihre Fotos wie mit fluoreszierenden Farben gemalt aussehen.

Das Programm erfordert keine besonderen Fähigkeiten, ist es einfach zu erlernen und anzuwenden. Es bietet eine Sammlung
von einsatzbereiten Presets, die helfen Ihnen, eine Vielzahl von wunderbaren Effekten zu erzielen.

Mit AKVIS Neon können Sie ein gewöhnliches Foto in eine wunderschöne leuchtende Zeichnung verwandeln!

Der magische Leuchteffekt macht Ihre Feierfotos noch gefühlvoller und fröhlicher! Das Programm hilft Ihnen, funkelnde
Weihnachts- und Neujahrsgrußkarten sowie individuelle Geburtstags- und Hochzeitseinladungen vorzubereiten.

Mit AKVIS Neon können Sie ein glühendes Bild, eine dramatische Landschaft bzw. ein außergewöhnliches Porträt erstellen;
oder einfach nur die Konturen eines Bildes hervorheben, um es interessanter und ausdrucksstarker zu gestalten.
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Das Programm kann ebenso bei der Gestaltung von Logos, Plakaten und Flyern behilflich sein. Ein leuchtendes Bild zieht die
Aufmerksamkeit sofort auf sich und erhöht die Attraktivität eines Produkts. Sie können schöne strahlende Hintergründe,
abstrakte Gemälde sowie eindrucksvolle Fotobuchillustrationen erstellen.
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Durch Experimentieren mit den Einstellungen erzielen Sie verschiedene Effekte: vom unscharfen Schein bis zu klaren
Konturlinien.

Die Software verfügt über eine Reihe von Funktionen, die in vielen anderen Programmen von AKVIS vorhanden sind:
Hinzufügen eines Textes, Anwendung einer Leinen-Textur, Freistellen von Bildern, Posten eines Bildes in sozialen Netzwerken,
Stapelverarbeitung und zusätzliche Werkzeuge zur Verfeinerung des Effekts.

AKVIS Neon gibt es als Zusatzmodul zur Integration in ein Bildbearbeitungsprogramm (Plugin) sowie als eigenständige Version
(Standalone).

Die Plugin-Version ist mit AliveColors, Adobe Photoshop, Photoshop Elements, Corel PaintShop Pro u.a. kompatibel.
Konsultieren Sie die Kompatibilitätstabelle für weitere Details.

Die Funktionalität des Programms hängt vom Lizenztyp ab. Während der Testperiode können Sie alle Optionen testen und
entscheiden, welcher Lizenztyp Ihren Bedürfnissen am besten entspricht.
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INSTALLATION UNTER WINDOWS

Nachfolgend finden Sie Anweisungen zur Installation der Programme von AKVIS unter Windows.

 

Sie müssen über Administratorrechte verfügen, um das Programm auf Ihrem Computer zu installieren.

Bevor Sie die AKVIS-Plugins installieren, vergewissern Sie sich bitte, dass der Bildeditor, in dem Sie die Plugins installieren
möchten, geschlossen ist. Oder führen Sie den Bildeditor nach der Installation des Plugins erneut aus.

 

1. Starten Sie die ausführbare Setupdatei (mit .exe-Dateiendung).
2. Wählen Sie die Sprache aus und klicken Sie auf Installieren, um den Installationsvorgang zu starten.
3. Um den Installationsvorgang fortzusetzen, müssen Sie die Lizenzbedingungen durchlesen und akzeptieren.

Aktivieren Sie das Kontrollkästchen "Ich stimme den Bedingungen der Lizenzvereinbarung zu" und klicken Sie auf
Weiter.

4. Um das Plugin zu installieren, wählen Sie Ihre Bildbearbeitungssoftware aus der Liste aus.

Um die Standalone-Version zu installieren, stellen Sie sicher, dass das Kontrollkästchen Standalone aktiviert ist. 
Um eine Verknüpfung des Programms auf dem Desktop zu erstellen, aktivieren Sie den Punkt  Verknüpfung auf
Desktop.

Klicken Sie auf die Schaltfläche Weiter.

5. Klicken Sie auf die Schaltfläche Installieren.

AKVIS Neon
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6. Die Installation ist gerade im Gange.

7. Die Installation ist beendet.

Sie können AKVIS Newsletter abonnieren, um Informationen über neue Produkte und spezielle Angebote aus erster
Hand zu erhalten. Geben Sie Ihre Email-Adresse ein.

AKVIS Neon
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8. Klicken Sie auf Fertig stellen, um das Setup zu beenden.

Nach der Installation der Standalone-Version von AKVIS Neon sehen Sie einen neuen Eintrag im Menü Start: AKVIS -  Neon.
Auf dem Desktop erscheint das Symbol der Verknüpfung, wenn Sie während der Installation das Kästchen Verknüpfung auf
Desktop aktiviert haben.

Nach der Installation der Plugins-Version von Neon sehen Sie einen neuen Eintrag im Filter/Effekte-Menü Ihrer
Bildbearbeitungssoftware. Z.B. in Photoshop: Filter -> AKVIS –> Neon, in AliveColors: Effekte -> AKVIS –> Neon.
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INSTALLATION UNTER MAC

Befolgen Sie die Anweisungen zur Installation der AKVIS-Software unter Mac.

Sie müssen über Administratorrechte verfügen, um das Programm auf Ihrem Computer zu installieren.

 

1. Öffnen Sie die virtuelle dmg-Disk:

- akvis-neon-app.dmg, um die eigenständige Standalone-Version zu installieren.

- akvis-neon-plugin.dmg, um die Plugin-Version in einem Bildbearbeitungsprogramm zu installieren.

2. Lesen Sie die Lizenzvereinbarung und klicken Sie auf Akzeptieren, wenn Sie die Bedingungen annehmen.

3. Finder öffnet sich und Sie sehen einen Ordner mit Dateien: AKVIS Neon Application oder AKVIS Neon Plugin.

 

4. Um die Standalone-Version zu installieren, ziehen Sie AKVIS Neon Application in den Ordner Programme oder ein
Verzeichnis Ihrer Wahl.

Um die Plugin-Version zu installieren, ziehen Sie den ganzen Ordner AKVIS Neon Plugin in den Plug-Ins Ordner Ihres
Bildbearbeitungsprogramms:

AliveColors: Sie können den Ordner für Plugins in den Optionen des Programms auswählen.

Photoshop CC 2023, CC 2022, CC 2021, CC 2020, CC 2019, CC 2018, CC 2017, CC 2015.5:
Library/Application Support/Adobe/Plug-Ins/CC.

Photoshop CC 2015: Applications/Adobe Photoshop CC 2015/Plug-ins.

Photoshop CS6: Applications/Adobe Photoshop CS6/Plug-ins.
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9



AKVIS Plugins unter Mac
(klicken um zu vergrößern)

Nach der Installation des Plugins AKVIS Neon sehen Sie einen neuen Eintrag in dem Filter/Effekte-Menü Ihres
Bildbearbeitungsprogramms. Wählen Sie in Photoshop: Filter -> AKVIS -> Neon, in AliveColors: Effekte -> AKVIS ->
Neon aus.

Führen Sie die Standalone-Version aus, indem Sie im Finder auf das entsprechende Symbol doppelklicken.

Sie können das AKVIS-Programm auch über die  Photos-App ausführen, indem Sie den Befehl  Bild -> Bearbeiten mit
auswählen (in High Sierra und späteren Versionen von macOS).

 

AKVIS Neon
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INSTALLATION UNTER LINUX

Befolgen Sie die Anweisungen, um die AKVIS-Software auf einem Linux-Computer zu installieren.

Hinweis: Die AKVIS-Programme sind mit Linux kernel 5.0+ 64-Bit kompatibel. Sie können die Kernel-Version mit dem
Befehl uname -srm herausfinden.

 

Installation auf Debian-basierten Systemen:

Hinweis: Sie benötigen apt-install- oder apt-get-Berechtigungen, um Software zu installieren.

1. Führen Sie das Terminal aus.
2. Erstellen Sie ein Verzeichnis zum Speichern von Schlüsseln: 

sudo mkdir -p /usr/share/keyrings
3. Laden Sie den Schlüssel herunter, mit dem das Repository signiert wurde: 

curl -fsSL https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null 
oder wget -O - https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null

4. Fügen Sie das Repository der Liste hinzu, in der das System nach zu installierenden Paketen sucht: 
echo 'deb [arch-=i386 signed-by=/usr/share/keyrings/akvis.gpg] https://akvis-
deb.sfo2.cdn.digitaloceanspaces.com akvis non-free' | sudo tee /etc/apt/sources.list.d/akvis.list

5. Aktualisieren Sie die Liste der bekannten Pakete: 
sudo apt-get update

6. Installieren Sie AKVIS Neon: 
sudo apt-get install akvis-neon

7. Die Installation ist abgeschlossen.

Starten Sie das Programm über das Terminal oder über die Programmverknüpfung.

8. Für automatische Updates verwenden Sie den Befehl: 
sudo apt-get upgrade

So entfernen Sie das Programm: 
sudo apt-get remove akvis-neon --autoremove

 

Installation auf RPM-basierten Systemen (CentOS, RHEL, Fedora):

1. Führen Sie das Terminal aus.
2. Registrieren Sie den Schlüssel, mit dem das Repository signiert wurde: 

sudo rpm --import https://akvis.com/akvis.asc
3. Fügen Sie das Repository dem System hinzu: 

sudo wget -O /etc/yum.repos.d/akvis.repo https://akvis.com/akvis.repo
4. Aktualisieren Sie die Paketliste:

beim Verwenden des dnf-Paketmanagers: 
sudo dnf update

beim Verwenden des yum-Paketmanagers: 
sudo yum update

5. Installieren Sie AKVIS Neon:

beim Verwenden des dnf-Paketmanagers: 
sudo dnf install akvis-neon

beim Verwenden des yum-Paketmanagers: 
sudo yum install akvis-neon

6. Die Installation ist abgeschlossen.

Starten Sie das Programm über das Terminal oder über die Programmverknüpfung.

7. Für automatische Updates verwenden Sie den Befehl:

beim Verwenden des dnf-Paketmanagers: 
sudo dnf upgrade

beim Verwenden des yum-Paketmanagers: 
sudo yum upgrade

8. So entfernen Sie das Programm:

beim Verwenden des dnf-Paketmanagers: 
sudo dnf remove akvis-neon

beim Verwenden des yum-Paketmanagers: 
sudo yum remove akvis-neon
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Installation auf openSUSE.

1. Führen Sie das Terminal aus.
2. Melden Sie sich als Root-Benutzer an.
3. Fügen Sie den Schlüssel hinzu, mit dem das Repository signiert wurde: 

rpm --import http://akvis.com/akvis.asc
4. Fügen Sie das Repository dem System hinzu: 

zypper ar -r https://akvis.com/akvis.repo akvis
5. Aktualisieren Sie die Paketliste: 

zypper ref
6. Installieren Sie AKVIS Neon: 

zypper install akvis-neon
7. Die Installation ist abgeschlossen.

Starten Sie das Programm über das Terminal oder über die Programmverknüpfung.

8. Für automatische Updates: 
zypper update

So entfernen Sie das Programm: 
zypper remove akvis-neon

 

Um die Programmoberfläche korrekt anzuzeigen, empfiehlt es sich, den Compton oder Picom Composite-Manager zu
installieren.
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SO AKTIVIERT MAN AKVIS SOFTWARE

Achtung! Während des Aktivierungsvorgangs muss Ihr Computer mit dem Internet verbunden sein.

Wenn Ihr Computer keinen Internetzugang hat, bieten wir Ihnen eine alternative Aktivierungsmöglichkeit an (siehe unten
Aktivierung ohne Internetzugang).

 

Laden Sie AKVIS Neon herunter und installieren Sie das Programm. Bevor Sie mit der Installation beginnen, lesen Sie die
Installationsanleitung.

Jedes Mal, wenn Sie eine unregistrierte Version starten, wird das Anfangsfenster angezeigt. Hier finden Sie allgemeine
Informationen über die Version des Programms und die Anzahl der restlichen Tage bis zum Ablauf der Testzeit.

Außerdem können Sie das Fenster Über das Programm öffnen, indem Sie auf die Schaltfläche   in der Optionsleiste des

Programms klicken.

 

Klicken Sie auf TESTEN, um die Software zu evaluieren. Ein neues Fenster mit Lizenz-Varianten zum Testen wird angezeigt.

Sie können das Programm ohne Anmeldung und Registrierung während der Testperiode ausprobieren (10 Tage nach dem ersten
Start).

Während der Testperiode können Sie alle Optionen testen und entscheiden, welcher Lizenztyp Ihren Bedürfnissen am besten
entspricht. Wählen Sie eine der angebotenen Lizenztypen: Home (Plugin oder Standalone), Home Deluxe, oder Business.
Die Funktionalität des Programms hängt von einem Lizenztyp ab. Für eine detailliertere Übersicht konsultieren Sie bitte die
Vergleichstabelle.

 

Klicken Sie auf KAUFEN, um eine Lizenz zu bestellen.

Sobald die Zahlung erfolgt ist, erhalten Sie Ihre persönliche Seriennummer an Ihre E-mail-Adresse innerhalb weniger Minuten.

 

Klicken Sie auf AKTIVIEREN, um den Aktivierungsvorgang zu starten.

AKVIS Neon
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Geben Sie Ihren Namen ein (das Programm wird auf diesen Namen registriert).

Geben Sie Ihre Seriennummer (Ihren Lizenzschlüssel) ein.

Wählen Sie eine Aktivierungsmethode — entweder direkte Verbindung zum Aktivierungsserver oder per E-Mail.

Direkte Verbindung zum Aktivierungsserver:

Es ist die einfachste Möglichkeit der Aktivierung.

Bei dieser Aktivierungsmethode muss Ihr Computer mit dem Internet verbunden sein.

Drücken Sie auf AKTIVIEREN.

Die Aktivierung ist nun abgeschlossen!

Aktivierungsanfrage per E-Mail senden:

Falls Sie die Aktivierung per E-Mail ausgewählt haben, erstellt das Programm eine Nachricht mit allen notwendigen
Informationen.

HINWEIS: Sie können diese Methode auch bei der Aktivierung ohne Internetzugang nutzen.

Wenn Ihr Computer nicht mit dem Internet verbunden sind, übertragen Sie die Aktivierungsanfrage auf einen anderen
Computer mit Internetzugang, z.B. per USB-Stick. Senden Sie uns diese Anfrage an: activate@akvis.com.

Bitte senden Sie keine Screenshots! Man muss den Text einfach kopieren und speichern.

Wir brauchen Ihre Seriennummer für die Software, Ihren Namen und Hardware ID (HWID) Ihres Computers.

Eine Lizenzdatei (Neon.lic) wird erstellt und Ihnen per E-Mail übersendet.

Speichern Sie die erhaltene .lic-Datei auf einen USB Stick und verlegen sie auf den Computer, auf welchem Sie das
Programm aktivieren möchten. Öffnen Sie die Datei nicht! Legen Sie die Lizenzdatei im AKVIS-Ordner ab:

Windows:

C:\Users\Public\Documents\AKVIS

(Dieser PC > Lokale Festplatte (C:) > Benutzer > Öffentlich > Dokumente > AKVIS)

Mac:

/Users/Shared/AKVIS

Öffnen Sie den  Finder, wählen Sie das Menü  Gehe zu, wählen Sie dann  Gehe zum Ordner...
(⌘ +Shift+G ), geben Sie "/Users/Shared/AKVIS" ein und klicken Sie auf Öffnen.

Linux:

/var/lib/AKVIS

Die Aktivierung ist nun abgeschlossen!

AKVIS Neon
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Nach der Aktivierung wird die Schaltfläche KAUFEN durch die Schaltfläche UPGRADE ersetzt. Mithilfe dieses Buttons können
Sie Ihre Lizenz verbessern (beispielsweise Home-Lizenz auf Home Deluxe oder Business upgraden).
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ARBEITSBEREICH

AKVIS Neon erlaubt es Ihnen, digitale Fotos in leuchtende Bilder zu verwandeln. Die Software steht in Standalone- und
Plugin-Version zur Verfügung.

Standalone ist ein eigenständiges Programm, das durch einen Doppelklick auf das Piktogramm des Programms geöffnet
wird.

Um die Standalone-Programmversion zu starten:

Unter Windows - wählen Sie das Programm in dem Start-Menü oder benutzen Sie die Verknüpfung des Programms
auf dem Desktop.

Unter Mac - starten Sie die Software aus dem Ordner Programme.

Plugin ist ein Zusatzmodul zur Integration in ein Bildbearbeitungsprogramm, z.B. in Photoshop.

Um das Plugin aufzurufen, wählen Sie es im Filter-Menü Ihres Bildbearbeitungsprogramms.

Der Arbeitsbereich wird gemäß dem ausgewählten Schnittstellenmodus angepasst: Express, Erweitert oder Presets.

Wenn Sie das Programm zum ersten Mal ausführen, wird es im Express-Modus mit einer vereinfachten Benutzeroberfläche und
einem minimalen Satz von Schiebereglern angezeigt. Dies ermöglicht einen schnellen Einstieg in die Arbeit.

Arbeitsbereich von AKVIS Neon (Express)

Erfahrene Benutzer, die mit den Funktionen von AKVIS Neon vertraut sind, können in den Erweiterten Modus wechseln, um
die volle Funktionalität des Programms nutzen zu können.

Hinweis: Alle Funktionen und Parameter funktionieren auch im Express-Modus. Einige sind ausgeblendet und das Programm
verwendet Werte eines ausgewählten Presets.

AKVIS Neon
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Arbeitsbereich von AKVIS Neon (Erweitert)

Mit der Schaltfläche Presets im oberen Panel des Programms können Sie in den Anzeigemodus Presets-Galerie wechseln.

Arbeitsbereich von AKVIS Neon (Presets-Galerie)

Das Bildfenster mit den Registerkarten Original und Ergebnis nimmt den größeren Teil des Programmfensters ein. Das
Originalbild wird im Original-Fenster angezeigt, das bearbeitete Bild erscheint im Ergebnis-Fenster. Sie können zwischen den
Registerkarten wechseln, indem Sie darauf klicken. Um das Originalbild und das Ergebnis zu vergleichen, klicken Sie auf das Bild
und halten Sie die Taste gedrückt.

AKVIS Neon
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Im oberen Bereich des Programmfensters befindet sich die Optionsleiste:

Die Schaltfläche   öffnet die Webseite von AKVIS Neon.

Mit der Schaltfläche   (nur in der Standalone-Version) öffnet man ein Bild zur Bearbeitung. Die Hotkeys sind Strg+O

auf Windows, ⌘ +O  auf Mac.

Mit der Schaltfläche   (nur in der Standalone-Version) speichert man das bearbeitete Bild. Die Hotkeys sind Strg+S

auf Windows, ⌘ +S  auf Mac.

Mit der Schaltfläche   (nur in der Standalone-Version) kann man das bearbeitete Bild drucken. Die Hotkeys sind

Strg+P  auf Windows, ⌘ +P  auf Mac.

Mit der Schaltfläche   kann man Presets laden (aus der .neon Datei).

Mit der Schaltfläche   kann man Presets exportieren. Die Einstellungen werden in einer Datei mit der Endung .neon

gespeichert.
Die Schaltfläche   löscht die zuletzt gezogene Linie. Der Hotkey ist Strg+Z  auf Windows, ⌘ +Z  auf Mac.

Die Schaltfläche   stellt die zuletzt gezogene Linie wiederher. Der Hotkey ist Strg+Y  auf Windows, ⌘ +Y  auf Mac.

Die Schaltfläche   (nur in der Standalone-Version) öffnet das Dialogfenster Stapelverarbeitung. Mit dieser Funktion

können Sie einen ganzen Ordner mit Fotos automatisch mit den gewählten Einstellungen bearbeiten lassen.
Mit der Schaltfläche   wird die Bildbearbeitung mit laufenden Einstellungen gestartet.

Mit der Schaltfläche   (nur in der Plugin-Version) werden die Änderungen angenommen und das Plugin wird

geschlossen.
Die Schaltfläche   ruft Informationen über das Programm auf.

Die Schaltfläche   ruft die Hilfe-Dateien auf.

Die Schaltfläche   ruft das Dialogfenster Optionen auf.

Die Schaltfläche   öffnet ein Fenster mit den neuesten Nachrichten über Neon.

 

Auf der l inken Seite bef indet sich die Werkzeugpalette mit verschiedenen Tools, die auf den Registerkarten
Original/Ergebnis angezeigt werden.

Vorbearbeitungswerkzeuge (aktiv in der Original-Registerkarte):

Die Schaltfläche   blendet das Vorschaufenster ein/aus.

Das Freistellen-Werkzeug  (nur in der Standalone-Version verfügbar) erlaubt es, überflüssige Teile des Bildes

wegzuschneiden. Das Werkzeug kann verwendet werden, um die Bildkomposition zu verbessern, ein schiefes Bild
auszurichten, ein horizontales Foto in ein vertikales Foto umzuwandeln und umgekehrt.

Nachbearbeitungswerkzeuge (aktiv in der Ergebnis-Registerkarte, nur für Home Deluxe/Business):

Die Schaltfläche   aktiviert das Wischfinger-Werkzeug, das das Bild manuell verfeinern lässt, indem man

Unebenheiten des Bildes entfernt. Das Werkzeug vermischt Farben durch eine Pixelverschiebung, als ob sie mit dem
Finger verstrichen werden.
Die Schaltfläche   aktiviert den Protokollpinsel, der die Bereiche in ihren ursprünglichen Zustand wiederherstellt.

Die Schaltfläche   aktiviert das Werkzeug Aufhellen. Das Tool erlaubt es, die Helligkeit in bestimmten Teilen des

Bildes zu erhöhen.
Die Schaltfläche   aktiviert das Werkzeug Abdunkeln. Das Tool erlaubt es, die Helligkeit in bestimmten Teilen des

Bildes zu verringern.

Zusätzliche Werkzeuge:

Die Schaltfläche   aktiviert das Verschieben-Werkzeug. Es wird verwendet, um den angezeigten Bereich des Bildes

im Fenster zu verschieben, wenn das ganze Bild nicht in das Fenster passt. Um das Bild zu scrollen, klicken Sie auf diese
Schaltfläche, bringen Sie den Cursor auf das Bild, drücken Sie die linke Maustaste und verschieben Sie das Bild bei
gedrückter Maustaste. 
Mit einem Doppelklick auf die Schaltfläche   wird die Abbildung der Programmfenstergröße angepasst.

Die Schaltfläche   aktiviert das Zoom-Werkzeug. Es ändert den Maßstab des Bildes. Um den Maßstab zu erhöhen,

drücken Sie auf die Schaltfläche und klicken Sie das Bild im Arbeitsbereich an. Um den Maßstab zu verringern, klicken
Sie auf das Bild mit der Alt -Taste. 

Mit einem Doppelklick auf die Schaltfläche   wird die Abbildung in ihrer Originalgröße (100%) dargestellt.

 

Das vorläufige Ergebnis wird automatisch im Vorschaufenster im Original-Register angezeigt. Im Navigator-Fenster kann
man das Bild skalieren. Der rote Rahmen zeigt den Bereich des Bildes, der im Bildfenster angezeigt wird. Wenn Sie den roten
Rahmen über das Bild verschieben, ändert sich der sichtbare Bereich im Bildfenster. Um den roten Rahmen zu verschieben,
bringen Sie den Cursor in den Rahmen hinein, drücken Sie die linke Maustaste und sie gedrückt haltend, ziehen Sie den
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Rahmen.

Navigator

Außerdem ist es möglich, das Bild im Bildfenster zu scrollen, indem Sie die Leertaste auf der Tastatur drücken und das Bild
mit der linken Maustaste ziehen. Benutzen Sie das Mausrad, um das Bild nach oben und nach unten zu verschieben; wenn die
Strg -Taste gedrückt wird, wird das Bild nach links oder nach rechts verschoben; wenn die  Alt -Taste gedrückt wird, kann
man das Bild skalieren. Mit einem Rechtsklick auf die Bildlaufleiste kann man das Menü Schnellnavigation öffnen.

Mit dem Schieberegler können Sie die Skalierung des Hauptbildes ändern. Indem Sie den Schieberegler nach rechts
verschieben, vergrößern Sie das Bild; indem Sie den Schieberegler nach links verschieben, verringern Sie das Bild im
Bildfenster.

Sie können auch einen Wert in das Feld eingeben.

Auch mit den Tasten +  und Strg++  auf Windows, ⌘ ++  unter Mac können Sie die Skalierung erhöhen und mit  -  und

Strg+-  auf Windows, ⌘ +-  unter Mac die Skalierung verringern.

 

Unter dem Navigator-Fenster befindet sich die Einstellungsleiste mit zwei Registerkarten:

Bild: Auf dieser Registerkarte kann man die Parameter des Neon-Effekts anpassen.

Gestaltung: Sie können Ihr Bild mit einem Text, einer Leinwand-Textur oder einem Rahmen versehen.

Im Presets-Bereich kann man die aktuellen Einstellungen speichern, um sie später zu verwenden. Die laufenden Einstellungen
können gespeichert, bearbeitet und entfernt werden. Nach dem Start des Programms werden die Einstellungen des zuletzt
benutzten Presets verwendet.

Unter den Einstellungen werden die Hinweise für die Parameter und die Schaltflächen angezeigt, über denen der Cursor
schwebt. In den Optionen des Programms kann man die Position der Hinweise anpassen oder sie ausblenden.
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FUNKTIONSWEISE

AKVIS Neon ist eine Fotobearbeitungssoftware, die Ihre Fotos in leuchtende Neonbilder verwandelt. Es gibt sowohl als
eigenständiges Programm (Standalone) als auch als Photoshop-Plugin.

Die Funktionalität des Programms hängt vom Lizenztyp ab. Während der Testperiode können Sie alle Optionen testen und
entscheiden, welcher Lizenztyp Ihren Bedürfnissen am besten entspricht.

Folgen Sie der Anleitung, um eine Zeichnung zu erstellen:

Schritt 1. Öffnen Sie ein Bild zur Bearbeitung:

- Wenn Sie mit der eigenständigen Version arbeiten:

Öffnen Sie das Dialogfenster Bild öffnen mit einem Doppelklick auf den leeren Arbeitsbereich des Programms oder
mit einem Klick auf . Benutzen Sie die Hotkeys: Strg+O  auf Windows, ⌘ +O  auf Mac. Sie können auch das

gewünschte Bild einfach in den Arbeitsbereich des Programms mit der Maus ziehen.
Die eigenständige Programmversion unterstützt die folgenden Formate: BMP, JPEG, RAW, PNG, WEBP und TIFF.

- Wenn Sie mit der Plugin-Version arbeiten:

Öffnen Sie ein Bild in Ihrem Bildbearbeitungsprogramm mit dem Befehl Datei -> Öffnen.

Rufen Sie das Plugin auf:

in AliveColors: Effekte -> AKVIS -> Neon; 
in Adobe Photoshop: Filter -> AKVIS -> Neon; 
in Corel PaintShop Pro: Effects -> Plugins -> AKVIS -> Neon; 
in Corel Photo-Paint: Effects -> AKVIS -> Neon.

Der Arbeitsbereich wird gemäß dem ausgewählten Schnittstellenmodus angeordnet: Express, Erweitert oder Presets.

Arbeitsbereich von AKVIS Neon

Schritt 2. Vor der Anwendung des Effekts in der Standalone-Version können Sie das  Freistellen-Werkzeug 

benutzen, um unerwünschte Teile der Bilder abzuschneiden und ihre Größe zu reduzieren.
Wenn Sie die Plugin-Version verwenden, können Sie das Bild in Ihrem Bildbearbeitungsprogramm freistellen.
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Freistellen-Werkzeug

Schritt 3. Passen Sie die Einstellungen in der Registerkarte Bild an. Sie können eines der einsatzbereiten  Presets
benutzen oder die Parameter nach eigenem Ermessen anpassen.

Das Ergebnis wird sofort in dem Vorschaufenster angezeigt, das im Original-Register bei gedrückter Taste   sichtbar

ist.

Vorschaufenster

Schritt 4. Klicken Sie auf , um das Bild in eine Zeichnung mit den ausgewählten Einstellungen zu konvertieren. Um

den Bearbeitungsprozess zu unterbrechen, klicken Sie auf die Abbrechen-Taste rechts neben dem Fortschrittsbalken.
Schritt 5. Benutzen Sie die Gestaltung-Optionen, um Ihr Bild mit einer Leinwand-Textur, einem Rahmen oder einem Text
zu versehen.

Hinweis: Die Reihenfolge der Anwendung von Leinwand/Rahmen/Text hängt von der Position der Registerkarten ab.
Ziehen Sie die Registerkarten, um die Reihenfolge zu ändern.
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Neonbild auf Leinwand mit der Signatur

Schritt 6. Es ist möglich, die laufenden Einstellungen als  Preset zu speichern, um sie später benutzen zu können.
Geben Sie im Presets-Feld einen Namen für das Preset ein und drücken Sie auf Speichern. Wenn ein neues Presets
erstellt wird, ist es in allen Registerkarten verfügbar und enthält alle Einstellungen.

Klicken Sie auf ein Herzsymbol neben dem Feld für den Namen des Presets, um die Voreinstellung zu den Favoriten
hinzuzufügen oder aus dieser Presets-Gruppe zu entfernen.

Mehr über die Neon-Presets erfahren.

Schritt 7. Die können das Ergebnis bearbeiten und Ihrer Zeichnung den letzten Schliff geben, indem Sie
Nachbearbeitungswerkzeuge anwenden: Wischfinger-Werkzeug , Protokollpinsel , Aufhellen-Werkzeug 

 und Abdunkeln-Werkzeug . Die Tools stehen nur für Home Deluxe und Business Lizenzen im Ergebnis-Register

zur Verfügung.

Achtung: Verwenden Sie diese Tools im letzten Schritt. Wenn Sie die Verarbeitung erneut ausführen  , gehen

die mit den Werkzeugen vorgenommenen Änderungen verloren!

Schritt 8. Die eigenständige Version von AKVIS Neon erlaubt das Drucken  des Bildes.

Schritt 9. Speichern Sie das bearbeitete Bild.

- Wenn Sie mit der eigenständigen Version arbeiten:

Klicken Sie auf , um das Dialogfeld Speichern unter zu öffnen. Sie können die Hotkeys benutzen:  Strg+S

auf Windows, ⌘ +S  auf Mac. Geben Sie einen Namen ein, wählen Sie ein Format (JPEG, TIFF, BMP, WEBP oder

PNG) und einen Zielordner aus.

- Wenn Sie mit der Plugin-Version arbeiten:

Klicken Sie auf , um die Änderungen anzunehmen. Das Plugin  AKVIS Neon wird geschlossen und das

bearbeitete Bild wird im Arbeitsbereich der Bildbearbeitungssoftware angezeigt.

Rufen Sie das Dialogfeld Speichern unter mit dem Befehl Datei -> Speichern unter auf. Geben Sie einen Namen
für die Datei ein, wählen Sie ein Format und einen Zielordner aus.
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Neon-Effekt auf Fotos
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NEONLINIEN-EFFEKT

AKVIS Neon verwandelt Fotos in Neonbilder. Mit dem Programm können Sie Ihren Bildern herausragende visuelle Effekte
hinzufügen und diese wie mit Licht gemalt aussehen lassen.

Leuchtlinien-Zeichnung aus einem Foto

 

Passen Sie die Einstellungen in dem Register Bild an.

Neben den Grundparametern können Sie Zusatzeinstellungen anpassen, die in der Gruppe Verstärkung angezeigt werden. Die
Einstellungen dieser beiden Gruppen wirken in ähnlicher Weise, werden aber auf verschiedenen Bearbeitungsstufen
angewendet.
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Detailstufe = 15

 
Detailstufe = 70

 
Farbenvielfalt = 30

 
Farbenvielfalt = 90

 
Intensität = 20

 
Intensität = 80

Detailstufe / Extra Detailstufe (0-100). Der Parameter legt die Anzahl der Linien fest, aus welchen das Bild besteht.

Farbenvielfalt (0-100). Wenn Sie den Parameterwert erhöhen, erscheinen zusätzliche Farben und Schattierungen im Bild. Je
höher der Wert des Parameters ist, desto heller und gesättigter werden sie.

Beim Nullwert des Parameters Detailstufe hat das Ändern des Parameters keinen Einfluss auf das Bild.

Leuchtintensität / Extra Leuchtintensität (1-100). Der Parameter bestimmt die Stärke und Helligkeit des Leuchtens.
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Glättung = 5

 
Glättung = 15

 
Abdunkeln = 15

 
Abdunkeln = 60

 
Detailschärfe = 10

 
Detailschärfe = 60

Glättung / Extra Glättung (2-25). Der Parameter ändert den Grad der Verwischung. Bei einer Erhöhung des Wertes wird das
Bild einfacher und die Konturen des Originalbildes werden unauffälliger.

Abdunkeln / Extra abdunkeln (0-100). Der Parameter fügt dunklere Schattierungen dem Bild hinzu und füllt die Bereiche mit
Schwarz.

Detailschärfe / Extra Detailschärfe (0-100). Der Parameter regelt die Schärfe von Linien.
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Ohne Invertierung

(beide Kästchen sind deaktiviert)

 
Doppelinversion

(beide Kästchen sind aktiviert)

 
Kästchen "Invertieren" aktiviert

 
Kästchen "Extra invertieren" aktiviert

Invertieren /  Extra invertieren. Wenn dieses Kontrollkästchen aktiviert ist, wird das Bild unschärfer und die Abdunkeln-
Option wird in einem Umkehrmodus als Aufhellen arbeiten. Bei einer Doppelinversion - wenn beide Kontrollkästchen aktiviert
sind - verwandeln sich leuchtende Linien in dunkle Konturen.

(eines der Kontrollkästchen ist aktiviert)
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Helligkeit = -50

 
Helligkeit = +50

 
Kontrast = -50

 
Kontrast = +50

 
Sättigung = -80

 
Sättigung = +80

Die Parameter im Anpassung-Register erlauben es Ihnen, den Tonwertumfang des Bildes anzupassen.

Helligkeit (-100 bis 100). Der Parameter definiert, wie stark das Bild beleuchtet wird. Bei höheren Werten wird es heller; bei
niedrigeren Werten wird es dunkler.

Kontrast (-100 bis 100). Der Parameter erhöht (bei Werten größer als 0) bzw. verringert (bei Werten kleiner als 0) den
Unterschied zwischen hellen und dunklen Bereichen des Bildes.

Sättigung (-100 bis 100). Der Parameter ändert die Intensität der Farben vom Grauton bis zur hellsten Farbe.
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Ausgangsfarben

(das Kontrollkästchen ist deaktiviert)

 
Farbton hinzugefügt

(das Kontrollkästchen ist aktiviert, Wert = 90)

 
Verschiebung in hellen Bereichen = -90

 
Verschiebung in hellen Bereichen = +90

 
Verschiebung in dunklen Bereichen = -90

 
Verschiebung in dunklen Bereichen = +90

Kolorieren (0-100). Mit dieser Option können Sie dem Bild einen Farbton verleihen. Sie können eine Farbe in dem Dialog
auswählen, der durch einen Doppelklick auf das Farbmuster geöffnet wird. Außerdem kann man eine Farbe direkt aus dem Bild
aufnehmen, indem man das Pipette-Werkzeug aktiviert und das Bild anklickt. Sie können den Farbmischungsgrad ändern, indem
Sie die Einstellungen anpassen. Bei dem maximalen Wert ergibt sich ein monotoner, einfarbiger Effekt.

Achtung! Diese Funktion ist nur für Lizenzen Home Deluxe und Business verfügbar.

 

In der Gruppe Farbton befinden sich Parameter, mit denen Sie die Farben einstellen können, ohne die Helligkeit des
Ausgangsbildes zu beeinflussen.

Verschiebung in hellen Bereichen (-180 bis 180). Der Parameter ändert nur helle Pixel.

Verschiebung in dunklen Bereichen (-180 bis 180). Der Parameter ändert nur dunkle Pixel.

Gesamtverschiebung (-180 bis 180). Der Parameter ändert alle Farben des Bildes.
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Gesamtverschiebung = 0

 
Gesamtverschiebung = 125

 
Intensität = 35

 
Intensität = 100

 
Länge der Striche = 30

 
Länge der Striche = 100

Winkel = 30 Winkel = -65

 

Die Registerkarte Schraffur erlaubt es, einen Schraffureffekt dem Bild hinzuzufügen.

Intensität (0-100). Der Parameter legt die Stärke des Effekts fest.

Länge der Striche (0-100). Der Parameter ändert die Länge der Striche und erlaubt es, unterschiedliche Ergebnisse zu
erzielen: von Punkten bis hin zu langen Streifen.

Winkel (-90 bis 90). Der Parameter legt den Neigungswinkel der Striche fest (in Grad).
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Stärke = 30 Stärke = 100

Verzerrungsgröße = 10 Verzerrungsgröße = 80

 

Die Einstellungen der Registerkarte Verzerrung erlauben es, ein Objekt umformen und verzerren. Der Effekt lässt das Bild
ausdrucksvoller und phantasieanregender wirken.

Achtung! Der Verzerrungseffekt ist nur für Deluxe- und Business-Lizenzen verfügbar.

 

Stärke (0-100). Die Intensität des Effekts. Bei 0 % findet keine Verzerrung statt.

Verzerrungsgröße (5-100). Der Parameter legt die Größe der Verzerrungen fest.

Zufallszahl (0-9999). Dies ist die Startnummer für den Zufallszahlengenerator, der die Form von Verzerrungen definiert.
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WERKZEUGE UND IHRE OPTIONEN

Die Werkzeugsätze in AKVIS Neon ändern sich automatisch bei Umschaltung zwischen den Registern Original und Ergebnis.

Werkzeugpalette,
Original-Register

Werkzeugpalette,
Ergebnis-Register

 

Die Werkzeuge des Programms werden in drei Gruppen unterteilt: Vorbearbeitungswerkzeuge (Original-Register),
Nachbearbeitungswerkzeuge (Ergebnis-Register) und Hilfswerkzeuge (Original und Ergebnis-Register).

Hinweis:
Mit den Schaltflächen   und  kann man die von diesen Werkzeugen , , ,  vorgenommenen

Änderungen rückgängig machen bzw. wiederherstellen.

 

Vorbearbeitungswerkzeuge (in dem Original-Register):

Das Vorschaufenster  ist ein gepunkteter Rahmen (diese punktierte Linie wird oft "marschierende Ameisen"

genannt), der die in den Registern Bild und Leinwand gemachten Änderungen widerspiegelt.

Das Vorschaufenster kann auf eine beliebige Position auf dem Bild mit der linken Maustaste oder durch einen Doppelklick
verschoben werden. Es erlaubt Ihnen, den Effekt in verschiedenen Bereichen des Bildes anzuzeigen. Um das Ergebnis
der automatischen Umwandlung mit dem Originalbild zu vergleichen, klicken Sie innerhalb des Vorschaubereichs und
halten Sie die Maustaste gedrückt.

Vorschaufenster

Die Größe des Vorschaufensters kann in den Optionen  des Programms angepasst werden.

Das Freistellen-Werkzeug  (nur in der Standalone-Version verfügbar) erlaubt es, überflüssige Teile des Bildes

wegzuschneiden. Das Werkzeug kann verwendet werden, um die Bildkomposition zu verbessern, ein schiefes Bild
auszurichten, ein horizontales Foto in ein vertikales Foto umzuwandeln und umgekehrt.

Hinweis: Dieses Werkzeug wird auf das Originalbild angewendet! Verwenden Sie es vor dem Neon-Effekt.

Um den Freistellungsbereich zu ändern, ziehen Sie an einer beliebigen Ecke oder Seite des Auswahlrechtecks bei
gedrückter linker Maustaste.

Um das Ergebnis anzuwenden und die Bereiche außerhalb des Rahmens zu entfernen, klicken Sie auf OK oder drücken
Sie auf Enter . Um das Freistellen rückgängig zu machen, klicken Sie auf Abbrechen oder drücken Sie auf  Esc . Um

den ursprünglichen Freistellungsbereich wiederherzustellen, klicken Sie auf Zurücksetzen.
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Bild freistellen

Passen Sie die Parameter an:

Sie können die Größe des Freistellungsbereichs mit den Optionen  Seitenverhältnis oder Fixierte Größe
auswählen.

Wenn das Kontrollkästchen Außenbereich aktiviert ist, können Sie die Farbe und Deckkraft der Außenbereiche
festlegen.

 

Nachbearbeitungswerkzeuge (in dem Ergebnis-Register, für Deluxe/Business):

Achtung! Die Werkzeuge , , ,  sind nur für die Lizenzen Home Deluxe/Business in dem Ergebnis-Register

verfügbar. Benutzen sie diese Werkzeuge im letzten Schritt. Wenn Sie die Bildbearbeitung neu starten , gehen

die mit Nachbearbeitungswerkzeugen vorgenommenen Änderungen verloren!

Parameter dieser Werkzeuge werden durch einen rechten Mausklick innerhalb des bearbeiteten Bildes angezeigt.

Anhand des Wischfinger-Werkzeugs  kann man das Bild manuell verfeinern, indem man Unebenheiten des Bildes

entfernt. Das Werkzeug vermischt Farben durch eine Pixelverschiebung, als ob sie mit dem Finger verstrichen werden.
Sie können Ihrem Gemälde einen handgemalten Effekt schnell verleihen.

Parameter des Werkzeuges:

Größe (1-300). Anhand dieses Parameters wird der Durchmesser des Pinsels angepasst.

Härte (0-100). Der Parameter legt den Grad der Verwaschung von Pinselkanten fest. Je größer der Wert, desto
härter ist die Pinselkante.

Stärke (1-100). Der Parameter legt die Verschmierung der Farben fest. Je höher der Parameterwert, desto stärker
wird die Farbe verstrichen.
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Neon-Effekt

 

Wischfinger angewendet

Protokollpinsel  erlaubt es, den Effekt verblassen zu lassen und das Bild in seinen ursprünglichen Zustand zu

versetzen.

Parameter des Werkzeugs:

Original wiederherstellen. Wenn das Kontrollkästchen aktiviert ist, erlaubt es das Werkzeug, den Neon-Effekt zu
schwächen und die mit den Werkzeugen vorgenommenen Änderungen zu bearbeiten. Wenn das Kästchen
deaktiviert ist, bearbeitet der Protokollpinsel nur die Änderungen, die mit den Tools vorgenommenen wurden.

Größe (1-1000). Die Breite der Linien, die mit dem Pinsel gezogen wird.

Härte (0-100). Der Parameter legt die Verschwommenheit der Kante fest. Je kleiner der Wert, desto
verschwommener sind die Kanten des Werkzeugs. Bei einem Wert von 100% ist die Grenze zwischen der Kanter
des Pinsels und dem Hintergrund deutlich erkennbar; bei niedrigeren Werten ist der Übergang zwischen diesen
Bereichen glätter.

Stärke (1-100). Der Grad der Wiederherstellung des ursprünglichen Zustandes. Bei niedrigeren Werten wird der
Bereich nicht vollständig wiederhergestellt, der Effekt vermischt sich mit dem Originalbereich. Bei 100% wird der
ursprüngliche Zustand vollständig wiederhergestellt.
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Zeichnungseffekt + Werkzeuge angewendet

 

Zeichnungseffekt wiederhergestellt

 

Neon-Effekt

 

Aufhellen

Aufhellen . Das Aufhellen-Werkzeug tont ein Bild, indem es die Farben aufhellt. Der Effekt wird mit jedem

überlappenden Pinselstrich stärker.

Parameter des Werkzeugs:

Größe (1-1000). Durchmesser des Werkzeuges.

Härte (0-100%). Der Parameter legt die Härte von Kanten fest. Je größer der Wert, desto härter ist die
Pinselkante.

Stärke (1-100). Die Stärke der Aufhellung. Bei einem Wert von 100% sind die Farben am hellsten.

Umfang. Das Aufklappmenü Umfang bietet drei Methoden der Bearbeitung an:

- Schatten. Dunkle Bereiche werden am stärksten verändert.

- Mitteltöne. Dunkle und helle Bereiche werden gleichermaßen verändert.

- Licht. Helle Bereiche werden am stärksten verändert.

Abdunkeln . Das Abdunkeln-Werkzeug tont ein Bild, indem es die Farbhelligkeit verringert.

Die Parameter sind gleich wie beim Aufhellen-Werkzeug.
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Neon-Effekt

 

Abdunkeln

 

Hilfswerkzeuge (aktiv in beiden Registern, für alle Lizenztypen):

Das Hand-Werkzeug  wird verwendet, um den angezeigten Bereich des Bildes im Fenster zu verschieben, wenn das

ganze Bild in das Fenster bei diesem Maßstab nicht passt. Um das Bild zu scrollen, klicken Sie auf diese Schaltfläche,
bringen Sie den Cursor auf das Bild, drücken Sie die linke Maustaste und, sie gedrückt haltend, verschieben Sie das Bild
im Fenster. Um das Werkzeug schnell zu aktivieren, drücken Sie die H -Taste auf der Tastatur.

Mit einem Doppelklick auf die Schaltfläche   wird die Abbildung der Programmfenstergröße angepasst.

Das Zoom-Werkzeug  ändert den Maßstab des Bildes. Um den Maßstab zu erhöhen, klicken Sie auf das Bild. Um den

Maßstab zu verringern, klicken Sie auf das Bild bei der gedrückten  Alt -Taste. Um das Werkzeug schnell zu aktivieren,

drücken Sie die Z -Taste auf der Tastatur.

Mit einem Doppelklick auf die Schaltfläche   wird die Abbildung in ihrer Originalgröße (100%) dargestellt.
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NEONBILDER AUF LEINWAND

Mit AKVIS Neon können Sie Ihrem Bild eine unregelmäßige Struktur verleihen: Sandpapier, MDF-Platten, Backsteinmauer usw.

In der Registerkarte Gestaltung wechseln Sie auf den Reiter Leinwand und aktivieren Sie das Kästchen Textur anwenden.

Hinweis: Sie können die Reiter  Leinwand/Rahmen/Text ziehen, um die Reihenfolge der Anwendung von
Gestaltungseffekten zu ändern.

Neon-Effekt auf texturiertem Papier

Sie können eine Textur aus der  Bibliothek -> Oberfläche auswählen oder Ihr Muster  laden:  Bibliothek ->
Benutzerdefiniert….

Passen Sie die Parameter der Leinwand an.
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RAHMEN

Auf der Registerkarte Rahmen können Sie Ihr Kunstwerk mit einem Rahmen versehen, um es zu vollenden.

Standardmäßig sind die Parameter dieser Registerkarte deaktiviert. Um den Bildrand zu gestalten, aktivieren Sie das Kästchen
Rahmen hinzufügen.

Hinweis: Sie können die Reiter  Leinwand/Rahmen/Text ziehen, um die Reihenfolge der Anwendung von
Gestaltungseffekten zu ändern.

Registerkarte 'Rahmen'

 

In der Drop-down-Liste wählen Sie einen Rahmentyp aus:

Klassischer Rahmen

Muster

Striche

Vignette

Passepartout
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TEXT AUF NEONBILD

Sie können Ihr Bild personalisieren, indem Sie eine Signatur, ein Logo oder ein Wasserzeichen einfügen.

Auf der Registerkarte Gestaltung wechseln Sie auf den Reiter Text und aktivieren Sie einen der Modi - entweder Text oder
Bild.

Hinweis: Sie können die Reiter  Leinwand/Rahmen/Text ziehen, um die Reihenfolge der Anwendung von
Gestaltungseffekten zu ändern.

Text auf Neonbild

Passen Sie die Parameter des Textes an.
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PRESETS FÜR NEON-EFFEKT

AKVIS Neon enthält eine Reihe gebrauchsfertiger Presets (Voreinstellungen), die Ihnen den Einstieg erleichtern. Wenn Sie den
Mauszeiger über ein Preset in der Dropdown-Liste bewegen, wird das schnelle Ergebnis im kleinen Fenster auf der linken Seite
der Liste angezeigt.

Um das Bild mit einem Preset zu verarbeiten, wählen Sie es in der Liste aus und klicken Sie auf die Schaltfläche  .

Ein Preset enthält die Einstellungen beider Registerkarten (Bild und Gestaltung).

Sie können eines der AKVIS-Presets wie es ist anwenden oder die Parameter verändern, um das gewünschte Ergebnis zu
erzielen.

Um Ihr eigenes Preset zu erstellen, geben Sie einen Namen in das Feld ein und drücken Sie auf Speichern.

Klicken Sie auf Zurücksetzen, um die Standardeinstellungen des ausgewählten Presets wiederherzustellen.

Um Ihr Preset zu löschen, wählen Sie es in der Dropdown-Liste aus und drücken Sie auf Löschen. Die eingebauten AKVIS-
Presets können nicht entfernt werden.

 

Neben dem Namen des Presets befindet sich das Herzsymbol. Klicken Sie darauf, um das ausgewählte Preset zu den
Favoriten hinzuzufügen oder aus dieser Presets-Gruppe zu entfernen.

 

Presets-Galerie

Klicken Sie im oberen Panel auf die Schaltfläche  Presets, um in den Presets-Anzeigemodus mit der Live-Vorschau zu
wechseln.
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Presets-Galerie

Sie sehen eine Liste der Presets, die alphabetisch (AKVIS-Presets) oder nach Erstellungsdatum (Benutzerpresets) sortiert
sind. Wenn ein Bild in das Programm geladen wird, werden Preset-Miniaturansichten generiert.

Klicken Sie auf eine Miniaturansicht, um das Preset auszuwählen. Ein Doppelklick auf die Miniaturansicht startet die
Verarbeitung des ganzen Bildes.

Doppelklicken Sie auf den Namen des Presets, um es umzubenennen. Die eingebauten AKVIS-Presets können nicht umbenannt
werden.

Verwenden Sie diese Schaltflächen, um die Anzeige der Presets zu ändern:

 - AKVIS-Presets anzeigen;

 - Benutzerpresets anzeigen;

 - als Favoriten markierte Presets anzeigen.

Die Preset-Miniaturansichten können folgenderweise angeordnet werden:

 - als vertikale Liste;

 - als Galerie.

Die Steuertasten werden durch die Kontextmenübefehle dupliziert:

 Zu Favoriten hinzufügen /  Aus Favoriten entfernen;

 Preset umbenennen (nur für Benutzerpresets);

 Nach oben verschieben (nur für Benutzerpresets);

 Nach unten verschieben (nur für Benutzerpresets);

 Preset löschen (nur für Benutzerpresets);

 Parameter anzeigen.
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Mit den Schaltflächen   und  lassen sich die Benutzerpresets exportieren bzw. importieren (Datei mit der Erweiterung

.neon). 
Lesen Sie mehr über das Importieren und Exportieren von Benutzerpresets.
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OPTIONEN

Die Schaltfläche   ruft das Dialogfenster Optionen auf. Es sieht so aus:

Sprache. Wählen Sie die gewünschte Sprache aus dem Menü aus.
Skalierung des Interfaces. Wählen Sie die Größe von Schnittstellenelementen. Wenn die Auto-Option ausgewählt
wird, erfolgt eine automatische Skalierung des Interfaces auf Basis der Bildschirmauflösung.
Farbe des Interfaces. Wählen Sie den gewünschten Stil der Programmschnittstelle: Hell oder Dunkel.
Skalierung des Bildes. Dieser Parameter definiert, wie das Bild im Bildfenster nach dem Öffnen skaliert wird. Es gibt
zwei Möglichkeiten:

- Ans Fenster anpassen. Das Bild wird so skaliert, dass es vollständig ins Bildfenster passt;
- Bei der Option 100% wird das Bild nicht skaliert. Beim Maßstab = 100% wird nur ein Teil des Bildes sichtbar.

Größe des Vorschaufensters. Wählen Sie den gewünschten Wert des Parameters. Die Größe des Vorschaufensters
kann die Werte von 200х200 Px bis 2000х2000 Px annehmen.
Max. Größe der Bearbeitung. Die Bildbearbeitung kann viel Zeit in Anspruch nehmen. Der Parameter ermöglicht die
Beschleunigung der Bildverarbeitung durch zeitweilige Verringerung der Bildgröße. Wenn die Dateigröße (in Megapixeln)
nicht den definierten Wert überschreitet, wird das Bild auf die übliche Weise bearbeitet. Wenn die geladene Bild größer
ist, wird das Programm seine Größe verringern, es bearbeiten und dann wieder auf die ursprüngliche Größe
zurückbringen.
Zuletzt verwendete Dateien (nur in der Standalone-Version). Legen Sie die Zahl der zuletzt geöffneten Dateien fest,
die mit einem Rechtsklick auf  angezeigt werden. Maximum: 30 Dateien.

Hinweise anzeigen. Sie können festlegen, wo die Hinweise erscheinen:

- Unter dem Bildfenster. 
-  Unter den Einstellungen. 
-  Ausblenden.

Optionsleiste fixieren. Es deaktiviert die Möglichkeit, die Optionsleiste ein- und auszublenden. Wenn das Kästchen
ausgewählt ist, wird dieses Panel immer angezeigt.

Um die vorgenommenen Änderungen zu speichern, klicken Sie auf OK.

Klicken Sie auf Standard wiederherstellen, um auf die Standardeinstellungen zurückzusetzen.
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STAPELVERARBEITUNG

AKVIS Neon unterstützt Stapelverarbeitung. Diese Funktion erlaubt es, eine Reihe von Bildern mit gleichen Einstellungen
automatisch zu konvertieren und dabei Zeit und große Anstrengungen zu sparen. Es ist nützlich, wenn Sie eine Reihe von
Illustrationen im gleichen Stil für eine Broschüre erstellen oder bei der Bearbeitung von Videoframes.

 

Wenn Sie die eigenständige Programmversion benutzen, folgen Sie diesen Schritten.

Wenn Sie die Plugin-Version von AKVIS Neon in Photoshop benutzen, lesen Sie die Anleitung hier.
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DRUCKEN VON BILDERN IN AKVIS NEON

Die eigenständige Version von AKVIS Neon erlaubt das Drucken des Bildes.
Klicken Sie auf die Schaltfläche  , um die Druckeinstellungen anzupassen.

Druckeinstellungen in AKVIS Neon

Passen Sie die Parameter in der Einstellungsleiste an:

Wählen Sie aus der Liste der verfügbaren Drucker den gewünschten Drucker aus. Legen Sie die Anzahl der zu
druckenden Kopien sowie die gewünschte Auflösung fest.

In der Parametergruppe Orientierung legen Sie die Orientierung des Bildes beim Drucken fest: Porträt (vertikal) oder
Album (horizontal).

Klicken Sie auf die Schaltfläche Seiteneinstellungen, um das Dialogfeld zu öffnen, in dem Sie die Seitengröße, die
Orientierung der Seite beim Drucken und die Breite der Kanten festlegen können.

Klicken Sie auf die Schaltfläche Ränder zurücksetzen, um die Standardeinstellungen wiederherzustellen.

Die Parameter Maßstab, Breite und Höhe und das Kästchen Auf Mediengröße skalieren legen die Druckgröße des
Bildes fest. Sie beeinflussen nicht das Bild selbst, sondern seine gedruckte Kopie. Es ist möglich, die Größe der
gedruckten Kopie zu ändern, indem man den Maßstab in Prozent festlegt (ein Wert unter 100% verringert das Bild, ein
Wert über 100% vergrößert es) oder indem man neue Werte für Breite und Höhe einträgt.

Um das Bild auf die ausgewählte Papiergröße zu skalieren, aktivieren Sie das Kästchen Auf Mediengröße skalieren.

Verschieben Sie das Bild mit der Maus oder mit den Pfeiltasten.

Sie können das zu druckende Bild mit einem Rahmen versehen. Die Breite und Farbe des Rahmens sind einstellbar.

Wählen Sie eine Hintergrundfarbe durch einen Klick auf das Farbmuster.

In dem Seite-Register können Sie mehrere Seiten auf ein Blatt Papier drucken lassen.
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Seite drucken

Kopien pro Blatt. Legen Sie fest, wie viele Kopien des Bildes auf ein Blatt Papier gedruckt werden.
Horizontal und Vertikal. Diese Parameter bestimmen, in wie vielen Spalten und Zeilen die Kopien des Bildes
dargestellt werden.
Abstand. Der Parameter stellt den Abstand zwischen den Kopien des Bildes ein.

In dem Poster-Register können Sie ein Bild auf mehrere Blätter verteilt ausdrucken und die Ausdrücke zu einem großen
Poster zusammenfügen.

Poster drucken

Blätter. Wenn das Kontrollkästchen aktiviert ist, können Sie die maximale Anzahl der Blätter festlegen, auf die das
Bild gedruckt wird. Das Bild wird so skaliert, dass es auf die gewünschte Anzahl Druckseiten passt. Wenn das
Kontrollkästchen deaktiviert ist, wird das Programm eine optimale Blattanzahl entsprechend der tatsächlichen
Bildgröße (Maßstab = 100%) automatisch auswählen.
Kleberänder. Aktivieren Sie dieses Kontrollkästchen, um die Breite der Kleberänder einzustellen. Die Ränder
werden rechts und unten gesetzt.
Schnittlinien. Aktivieren Sie dieses Kontrollkästchen, um die Schnittmarkierungen zu drucken. Sie helfen Ihnen
beim Zusammensetzen des Bildes.
Seitenzählung. Aktivieren Sie dieses Kontrollkästchen, um jedes Bildteil zu nummerieren. Nummer der Zeile und
Spalte wird am Rand gedruckt.

Um den Druckprozess zu starten, klicken Sie auf die Schaltfläche Drucken. 
Um das Dialogfeld ohne Drucken des Bildes zu schließen, klicken Sie auf Abbrechen.

Klicken Sie auf die Schaltfläche  Eigenschaften..., um ein Systemdialogfeld zu öffnen, wo Sie erweiterte Einstellungen
anpassen und das Dokument drucken können.
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Original Ergebnis

WEIHNACHTSGRUSSKARTE

AKVIS Neon kann ein digitales Foto in eine funkelnde Grußkarte umwandeln und lässt eine festliche, weihnachtliche Stimmung
aufkommen.

Das Beispiel wurde mithilfe der Plugins AKVIS Neon und AKVIS ArtSuite in dem Grafikeditor Adobe Photoshop erstellt.

 

Folgen Sie den Schritten, um eine Grußkarte zum Neujahr zu erstellen:

Schritt 1. Öffnen Sie ein Bild in Adobe Photoshop.

Ausgangsbild

Schritt 2. Benutzen Sie Horizontales Textwerkzeug, um eine Glückwunschaufschrift hinzuzufügen.

Glückwunschaufschrift hinzufügen

Fassen Sie die Textebene und der Hintergrundebene zusammen.

Schritt 3. Mit dem Plugin AKVIS ArtSuite versehen Sie das Bild mit einem Rahmen (Befehl Filter -> AKVIS -> ArtSuite).
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In der Einstellungsleiste wählen Sie den Rahmen Sprühen und passen Sie die Parameter nach eigenem Geschmack an.

Plugin-Fenster von AKVIS ArtSuite

Klicken Sie auf die Schaltfläche  , um die Änderungen zu übernehmen das Plugin-Fenster zu schließen.

Schritt 4. Verwandeln Sie das Bild in eine Neon-Zeichnung. Dazu rufen Sie das Plugin AKVIS Neon auf (Befehl Filter ->
AKVIS -> Neon).

Sie können nun eines der Presets auswählen oder eigene Einstellungen vornehmen.

Plugin-Fenster von AKVIS Neon
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Drücken Sie auf den Knopf  , um das ganze Bild zu bearbeiten.

Schritt 5. Schwächen Sie gegebenfalls den Leuchteffekt mit dem Protokollpinsel .

Man kann z.B. die Aufschrift mit diesem Werkzeug bearbeiten, damit sie lesbarer wird.

Protokollpinsel angewendet

Mit einem Klick auf  wenden Sie das Ergebnis an.

Machen Sie Ihren Liebsten eine Freude mit dieser individuell gestalteten Weihnachtsgrußkarte!

Weihnachtsgrußkarte
(zum Vergrößern anklicken)
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Original

 

Ergebnis

ILLUSION: PSYCHEDELISCHES PORTRÄT

In diesem Beispiel benutzen wir einen Graphikeditor und zwei Plugins: AKVIS Draw und AKVIS Neon. Zuerst erstellen wir ein
Basisbild, welches mit zahlreichen Strichen gezeichnet sein sollte. Danach werden wir diese Striche in feine leuchtende Linien
umwandeln.

Schritt 1. Wäh len  S ie  e in  B i l d   (vo rzugswe i se   in  e inem dunk len  Fa rb ton) .  Ö f fnen  S ie  es   i n   Ih rem
Bildbearbeitungsprogramm und erstellen Sie eine Kopie der Ebene:

Ausgangsfoto

Schritt 2. Rufen Sie das Plugin AKVIS Draw auf. Passen Sie die Einstellungen nach Ihrem Geschmack an. Oder Sie
können ein einsatzbereites Preset anwenden, das die meisten Details bewahrt.
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Plugin-Fenster von AKVIS Draw

Schritt 3. Führen Sie die Bearbeitung durch, indem Sie auf die Schaltfläche   drücken. Nehmen Sie das Ergebnis

durch einen Klick auf  an.

Bleistiftzeichnung

Schritt 4. Wenn sie wollen, können Sie das Bild heller machen. Dazu verwenden Sie jeweilige Farbkorrekturverfahren, die
Ihnen Ihre Bildbearbeitungssoftware zur Verfügung stellt.
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Nach der Bearbeitung mit AKVIS HDRFactory

Schritt 5. Rufen Sie das AKVIS Neon Plugin auf: Filter -> AKVIS -> Neon. Verwenden Sie das Vorschaufenster, um die
Effektparameter anzupassen.

Plugin-Fenster von AKVIS Neon

Eine Menge von feinen leuchtenden Linien erscheinen auf dem Bild. Nachdem die Bearbeitung fertig gestellt ist, nehmen
Sie das Ergebnis durch einen Klick auf die Schaltfläche   an.
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Nach der Bearbeitung mit AKVIS Neon

Schritt 6. Alles, was wir jetzt tun müssen, ist den Mischmodus in der Ebenenpalette zu ändern. Unser ausdrucksstarkes
psychedelisches Porträt ist nun fertig!

Ebenenpalette
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Psychedelisches Porträt
(zum Vergrößern anklicken)
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Original Ergebnis

MAGISCHES RENTIER

Mit AKVIS Neon können Sie ein beliebiges Foto in eine effektvolle Zeichnung umwandeln. Im Folgenden wird gezeigt, wie man
den Effekt verstärken bzw. schwächen kann.

Schritt 1. Öffnen Sie ein Bild in dem Programm.

Ausgangsfoto

Schritt 2. Passen Sie die Effektparameter an. Sie können die  Kolorieren-Option in der Anpassung-Registerkarte
benutzen, um einen funkelnden blauen Hintergrund zu erstellen.

Beachten Sie, dass diese Option nur für Lizenzen Home Deluxe und Business verfügbar ist.
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Einstellungen in AKVIS Neon

Schritt 3. Starten Sie die Bearbeitung durch einen Klick auf . Das Ergebnis sieht wie folgt aus:

Koloriertes Bild

Schritt 4. Benutzen Sie den Protokollpinsel , um den Effekt in einigen Bereichen des Bildes zu schwächen.
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Protokollpinsel angewendet

Schritt 5. Speichern Sie das Ergebnis mit einem Klick auf .

Wenn Sie die Bearbeitung wiederholt ausführen (diesmal ohne Kolorieren), wird der Schein intensiver.

Wiederholte Bearbeitung in AKVIS Neon
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Ergebnis
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AKVIS SOFTWARE

 

AKVIS AirBrush — Airbrush-Technik in Fotos

AKVIS AirBrush lässt Ihre Fotos wie mit einer Spritzpistole gezeichnet aussehen. Weiter…

 

AKVIS Artifact Remover AI — JPEG-Kompressionsartefakte beseitigen

AKVIS Artifact Remover AI verwendet fortgeschrittene Algorithmen der künstl ichen Intell igenz, um JPEG-
Kompressionsartefakte zu entfernen und die ursprüngliche Qualität komprimierter Bilder wiederherzustellen. Das Programm
bietet 4 Bildverbesserungsmodi, bei denen jeweils ein einzigartiges neuronales Netzwerk zum Einsatz kommt. Die Software ist
für Privatanwender kostenlos erhältlich. Für die kommerzielle Nutzung wird eine Business-Lizenz angeboten. Entfalten Sie die
ganze Schönheit Ihrer Fotos! Weiter…

 

AKVIS ArtSuite — Bilderrahmen und Effekte für Ihre Fotos

AKVIS ArtSuite versieht Digitalfotos mit schönen Bilderrahmen. Ein richtig ausgewählter  Bilderrahmen ergänzt Ihr Bild und
bringt es zur besonderen Geltung. 
Das Programm stellt eine große Auswahl unterschiedlichster Rahmen bereit.  Außerdem erlaubt es, eigene Bilder für die
Erstellung des originellen Rahmens zu benutzen. Weiter…
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AKVIS ArtWork — Vielseitige Sammlung von Maltechniken

AKVIS ArtWork imitiert verschiedene Mal- und Zeichentechniken. Das Programm bietet diese Stilmöglichkeiten an: Ölgemälde,
Aquarell, Gouache, Comic, Tintenzeichnung, Linolschnitt, Pastell und Pointill ismus. Ob ein Ölporträt oder eine
Landschaftsmalerei, das Programm wird Ihre Ideen erfolgreich umsetzen. Weiter…

 

AKVIS Chameleon — Erstellung von Fotocollagen

AKVIS Chameleon ist ein wunderbares Programm für Erstellung von Fotocollagen mit automatischer Adaptierung der
eingesetzten Objekte in Bezug auf die Farbe des Hintergrundes sowie deren Kantenglättung. Das Programm erfordert nicht die
exakte Auswahl der Objekte. Kopieren Sie das Objekt, setzen Sie es in das Bild ein, und er adaptiert die Farbskala des Bildes
und seine Ränder glätten sich. Weiter…
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AKVIS Charcoal — Kohle- und Kreidezeichnungen

AKVIS Charcoal ist ein künstlerisches Werkzeug zur Umwandlung von Fotos in Kohle-, Kreide- und Rötelzeichnungen. Weiter…

 

AKVIS Coloriage — Bildeinfärbung und Farbenänderung

AKVIS Coloriage ändert die Farben eines Fotos: von der Einfärbung Schwarz-Weiß-Fotos bis hin zur Farbenänderung auf Ihren
Farbfotos.
Kein Hantieren mit Ebenen - malen Sie einfach ein paar Striche mit den gewünschten Farben und das Programm erledigt den
Rest. Weiter…

 

AKVIS Decorator — Oberflächengestaltung und Farbveränderung

AKVIS Decorator erlaubt es, die Oberfläche eines Objekts zu verändern. Wählen Sie einen Teil des Bildes aus, z.B. das Kleid
eines Mädchens, und wenden neue Texturen darauf an. Das Mädchen bekommt ein geflecktes oder kariertes Kleid, das
aussieht als wäre es aus Samt oder Seide, oder sogar aus Holz oder Süßigkeiten. Weiter…
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AKVIS Draw — Skizzeneffekt in Fotos

AKVIS Draw lässt Fotos wie mit einem Bleistift gezeichnet aussehen. Die Software funktioniert wie ein Kunstfilter, der Fotos in
stilvolle Skizzen durch Anpassung der Einstellungen umwandelt. Weiter…

 

AKVIS Enhancer — Bildkorrektur und Detailoptimierung

AKVIS Enhancer ist ein Werkzeug, um Bilder zu retten, die wegen falscher Belichtung nicht optimal aussehen. Das Programm
gibt Ihnen die Möglichkeit, Details in unterbelichteten und überbelichteten Bereichen eines Fotos aufzudecken. Das Programm
hat drei Modi: Detailoptimierung, Druckvorbereitung und Tonkorrektur. Weiter…

 

AKVIS Explosion — Spektakuläre Explosionseffekte

AKVIS Explosion bietet kreative Zerstörungs- und Explosionseffekte für digitale Fotos. Das Programm imitiert den Sandsturm-
Effekt und fügt Ihren Bildern fliegende Partikel hinzu. Mit der Software können Sie Ihre Entwürfe ganz einfach explodieren
lassen! Weiter…
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AKVIS Frames — Farbenfrohe digitale Fotorahmen

AKVIS Frames ist eine kostenlose Foto-Editing-Software, die speziell für die Arbeit mit Rahmenpaketen von AKVIS entwickelt
wurde. Mit dem Programm können Sie Ihre Fotos mit exklusiven Bilderrahmen schnell und einfach versehen! Weiter…

 

AKVIS HDRFactory — HDR-Bilder: Über die Wirklichkeit hinaus

AKVIS HDRFactory ist ein vielseitiges Programm zum Erstellen von HDR-Bildern sowie für kreative Gestaltung der Fotos.
HDRFactory erstellt HDR aus mehreren Aufnahmen des gleichen Objekts mit unterschiedlichen Belichtungszeiten. HDRFactory
erlaubt es Ihnen, sogar den HDR-Effekt auf einem Bild nachzuahmen. Das Programm kann auch für Fotokorrektur verwendet
werden. Weiter…

 

AKVIS Inspire AI — Kunstwerke leicht gemacht!

AKVIS Inspire AI stilisiert Bilder anhand verschiedener Gemäldemuster. Das KI-basierte Programm ahmt das Farbschema und
den Stil eines ausgewählten Kunstwerks nach und schafft so ein neues Kunstwerk. Die Software umfasst eine Galerie von
Kunststilen und ermöglicht das Laden eines benutzerdefinierten Musters. Imitieren Sie den Stil weltberühmter Künstler!
Weiter…
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Weiter…

 

AKVIS LightShop — Licht- und Sterneneffekte

AKVIS LightShop erlaubt es Ihnen, eine endlose Zahl von erstaunlichen Lichteffekten zu erstellen! Das Programm bietet
fortgeschrittene Techniken zur Erstellung von Sternen- und Lichteffekten auf Ihren Fotos. Ein Lichteffekt kann jedes Foto
beleben und auffrischen. Fügen Sie Ihren Fotos einen Hauch von Magie hinzu! Weiter…

 

AKVIS Magnifier AI — Bilder vergrößern und Bildqualität verbessern

Mit AKVIS Magnifier AI können Sie Fotos verlustfrei vergrößern und gleichzeitig die Bildqualität verbessern. Mit innovativen
KI-Algorithmen skaliert Magnifier AI Bilder auf eine superhohe Auflösung von bis zu 800% und erstellt wandgroße Drucke.
Verbessern Sie die Bildauflösung, erstellen Sie detaillierte Bilder ohne Verpixelung oder Unschärfe! Weiter…

 

AKVIS MakeUp — Porträtverbesserung

AKVIS MakeUp ist eine Software zur Porträtverbesserung, die Ihren Fotos einen professionellen Look verleiht.

Die Software verfeinert die Hautstruktur auf Porträtaufnahmen und lässt den Teint strahlen. Es ist schon erstaunlich, wie viel
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ein gutes Hautbild zum Verjüngen und Auffrischung des Gesichts beibringen kann. Weiter…

 

AKVIS NatureArt — Natur-Effekte auf digitalen Fotos

AKVIS NatureArt ist ein ausgezeichnetes Werkzeug zur Nachahmung der Schönheit der Naturphänomene auf Ihren digitalen
Fotos. Das Programm enthält eine ganze Reihe von Effekten: Regen

 

AKVIS Neon — Leuchtbilder aus Fotos

AKVIS Neon ist eine Software zur Umwandlung von Fotos in leuchtende Zeichnungen. Das Programm transformiert Fotos in
Neonbilder, die wie mit fluoreszierenden Farben gezeichnet aussehen. Weiter…
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AKVIS Noise Buster AI — Verringerung des Bildrauschens

AKVIS Noise Buster AI verringert Rauschen auf digitalen Bildern. Das digitale Rauschen kann als zahlreiche helle, dunkle oder
farbige Bildpunkte auf einfarbigen Flächen auftreten. Nach der Anwendung sehen Ihre Fotos sauber und fehlerfrei aus. Weiter…

 

AKVIS OilPaint — Ölgemälde-Effekt

AKVIS OilPaint lässt digitale Fotos wie echte Ölgemälde aussehen. Die geheimnisvolle Herstellung eines Gemäldes geschieht
direkt vor Ihren Augen. Der einzigartige Algorithmus erlaubt es, die Technik eines echten Pinsels authentisch zu reproduzieren.
Mit dieser innovativen Software können Sie ein richtiger Künstler werden! Weiter…

 

AKVIS Pastel — Pastellgemälde aus Fotos

AKVIS Pastel verwandelt Ihre Fotos in Pastellgemälde. Das Programm konvertiert Ihre Bilder in lebensechte digitale
Kunstwerke, indem es eine der beliebtesten künstlerischen Maltechniken imitiert. AKVIS Pastel ist ein leistungsfähiges
Werkzeug, um Ihr kreatives Potenzial zu entdecken und auszuleben! Weiter…

AKVIS Neon

66

https://akvis.com/de/neon/index.php?utm_source=help
https://akvis.com/de/noise-buster/index.php?utm_source=help
https://akvis.com/de/noise-buster/index.php?utm_source=help
https://akvis.com/de/noise-buster/index.php?utm_source=help
https://akvis.com/de/oilpaint/index.php?utm_source=help
https://akvis.com/de/oilpaint/index.php?utm_source=help
https://akvis.com/de/oilpaint/index.php?utm_source=help
https://akvis.com/de/pastel/index.php?utm_source=help
https://akvis.com/de/pastel/index.php?utm_source=help


 

AKVIS Points — Pointillismus-Effekt in Fotos

AKVIS Points verwandelt Ihre digitalen Fotos in Gemälde in pointillistischer Malweise. Diese Technik zählt zu einer der
ausdrucksstärksten Stilrichtungen in der Malerei. Entdecken Sie Geheimnisse des Pointillismus mit AKVIS Points! Weiter…

 

AKVIS Refocus AI — Scharfstellung und Weichzeichnung

AKVIS Refocus AI stellt verschwommene Bilder scharf. Das Programm kann das ganze Foto oder nur einen ausgewählten Teil
davon in den Fokus stellen, damit das Aufnahmemotiv besser zur Geltung kommt. Außerdem ist es möglich, Bokeh- und
Weichzeichnungseffekte auf Ihre Fotos zu erstellen.

Die Software stellt fünf Modi zur Verfügung:  Scharfstellung AI, Iris-Weichzeichnung, Tilt-Shift, Bewegungsunschärfe und
Radiales Weichzeichnen. Weiter…

 

AKVIS Retoucher — Software zur Fotorestaurierung

AKVIS Retoucher ist eine effektive Fotorestaurierungssoftware für Kratzer-und Staubbeseitigung. 
Die Software hilft nicht nur Kratzer, Risse, Schmutz und sonstige Beschädigungen zu beseitigen, sondern auch die fehlenden
Teile des Fotos zu rekonstruieren, indem die angrenzenden Bereiche zur Wiederherstellung herangezogen werden. Weiter…
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AKVIS Sketch — Fotos in Zeichnungen umwandeln

AKVIS Sketch verwandelt Fotos in hochrealistische Bleistiftzeichnungen. Die Software erstellt wunderschöne S/W und farbige
Zeichnungen, die die Technik der Graphit-, Bleistift-, Kohle-, Pastell- und Aquarellzeichnung nachahmen. Das Programm bietet
folgende Zeichenstile: Klassischen, Künstlerischen, Maestro und Multistil - jeweils mit einer Reihe von Voreinstellungen. Mit
AKVIS Sketch brauchen Sie keinen Bleistift, um sich als Künstler zu fühlen! Weiter…

 

AKVIS SmartMask — Objekte aus Foto ausschneiden

AKVIS SmartMask ist ein Maskierungswerkzeug, das die Auswahl schwieriger Objekte innerhalb weniger Sekunden erlaubt,
ohne sie genau zu markieren.

Nie war die Auswahl so einfach! Weiter…
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AKVIS Watercolor — Aquarell-Effekt auf Fotos

AKVIS Watercolor verwandelt Fotos in erstaunlich realistische Aquarellbilder. Das Programm bietet zwei Konvertierungsstile:
Klassisches Aquarell und Kontur-Aquarell. Jeder Stil kommt mit einer großen Auswahl an gebrauchsfertigen Presets. Das
Programm erlaubt es, großartige Meisterwerke mit nur einem Klick erstellen! Weiter…

AKVIS Neon

69

https://akvis.com/de/smartmask/index.php?utm_source=help
https://akvis.com/de/watercolor/index.php?utm_source=help
https://akvis.com/de/watercolor/index.php?utm_source=help
https://akvis.com/de/watercolor/index.php?utm_source=help

